Full Circle

BOOK REVIEW

THE INDEPENDENT MAGAZINE FOR THE UBUNTU LINUX COMMUNITY

ISSUE #92 - December 201 4

X - P L AN E 1 0
ENTERING A FLIGHT PLAN
full circle magazine #92

1

Fu ll Ci rcle M a g a zi n e i s n e i th e r a ffi li a te d wi th , n o r e n d o rse d b y, Ca n o n i ca l Ltd .

contents ^

Full Circle

HowTo
Make A Special Edition

p.1 2

LibreOffice

p.1 4

Nautilus Bulk Print

p.1 8

THE INDEPENDENT MAGAZINE FOR THE UBUNTU LINUX COMMUNITY

Command & Conquer

Linux Labs

p.1 0

p.32

BACK NEXT MONTH
Blender

p.XX

Graphics

p.21

p.04

Arduino

p.24

Linux Labs

p.27

Review

p.35

My Story

p.39

Q&A

p.42

Ubuntu Games

p.44

BACK NEXT MONTH
Letters

p.40

BACK NEXT MONTH
Inkscape

Linux News

Security

p.XX

Tuxidermy

p.45

BACK NEXT MONTH
Ubuntu Women

p.XX

The articles contained in this magazine are released under the Creative Commons Attribution-Share Alike 3.0 Unported license.
This means you can adapt, copy, distribute and transmit the articles but only under the following conditions: you must attribute
the work to the original author in some way (at least a name, email or URL) and to this magazine by name ('Full Circle Magazine')
and the URL www.fullcirclemagazine.org (but not attribute the article(s) in any way that suggests that they endorse you or your use of the work). If
you alter, transform, or build upon this work, you must distribute the resulting work under the same, similar or a compatible license.
Full Circle magazine is entirely independent of Canonical, the sponsor of the Ubuntu projects, and the views and opinions in the
fullhave
circleCanonical
magazineendorsement.
#92
2
magazine should in no way be assumed to
contents ^

E D I T O R I AL

This magazine was created using :

WELCOME TO THE LAST ISSUE OF FULL CIRCLE. FOR 201 4 THAT IS.

M

an down. Man down! After making such a triumphant return last month, Greg is ill, so
no Python this month I'm afraid. Still haven't heard anything from Nicholas, so no
Blender again, but there is some Inkscape. We do have a great article from Brian (the nice
man who brings you the FCM EPUB every month) who shows you how to make your own
Special Edition PDF. Also, a handy How-To on doing bulk printing from within Nautilus with a
menu shortcut.
I've started a new Arduino project this month, and also written another X-Plane 1 0 article.
This one is on how to plan, then enter, your flight route. I've recently bought a USB joystick
card which I hope to link to X-Plane to create a real-world switch box with which to control XPlane. If it goes well I'll (obviously!) create an article about it for FCM.
Our kernel series reaches its second-to-last article, and Charles shows how he uses SSH to
graphically rename his networked collection. For reviews, we have a quick look at Scilab, and
a review of the 'Build Your Own Website' book. Which is more graphic novel than text book.
This is, of course, the last FCM of 201 4. I hope you've enjoyed the past eleven issues, and
will continue to read on through 201 5.

All the best to you, and yours, for 201 5!

Full Circle Podcast

Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:

Ronnie
ronnie@fullcirclemagazine.org

• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark
http://fullcirclemagazine.org
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N E WS
SAY HI TO LINUX' S FUTURE:
FEDORA 21 IS HERE

I

E

verybody went back to work
today and there is so much
news I hardly know where to start.
The top story tonight is bound to
be the official forking of Debian. In
other news, Dediomedio.com says
Ubuntu 1 4.1 0 MATE is "almost
fabulous" and the Free Software
Foundation released their 201 4 gift
buying guide. Mint 1 7.1 is almost
here and a Fedora 21 release
candidate has been released. Carla
Schroder has an exclusive on
Linux.com about being a maker
instead of a user and, finally, a
bunch of too-good-to-resist tidbits.

f you want to see where
enterprise Linux is going, you
should look at Red Hat's
community Linux distribution,
Fedora, today. Say hello to Fedora
21 's default GNOME 3 desktop.It's
in Fedora that Red Hat explores
the cutting edge of Linux and open
source software developments.
While not everyone will like where
Fedora is going -- for example,
Fedora's init system systemd still
has many detractors -- it's still the
bellwether for Linux. If a software
library or program isn't in Fedora at Source:
http://ostatic.com/blog/debiansome point, it's not likely to ever
forked-ubuntu-mate-fabulous-andshow up in mainstream Linux.
fedora-21 -rc1
Submitted by: Arnfried Walbrecht
Source:
http://www.zdnet.com/article/sayhi-to-linuxs-future-fedora-21 -ishere/
I MAGINATION BRINGS
Submitted by: Peter Odigie
VIRTUALISED LINUX SECURITY

D EBIAN FORKED, U BUNTU
MATE FABULOUS, AND
FEDORA 21 RC1

TO THE I NTERNET OF THINGS

I

MAGINATION TECHNOLOGIES
has announced the creation of a
full circle magazine #92

tiny hypervisor rig to power its
MIPS-based CPUs. The joint
venture with Japanese firm Seltech
saw the Fexerox hypervisor
embedded firmware from Seltech
paired with an Imagination
MIPSM51 50 CPU to create a
virtualised environment, allowing
multiple operating systems to run
independently off a single unit
packed into a tiny space.

THE IMPACT OF THE LINUX
PHILOSOPHY

W

hether we know it or not,
most of us have some sort of
philosophy of life. It may be as
simple as, "Be kind to others," or it
might be a very complex life
philosophy.

Many companies have some sort
of
philosophy
as well. They may be
A recent demonstration at the
Embedded Technology Conference unwritten or well-documented.
When I worked at IBM, from 1 974
in Japan showed a real-time
through 1 995, the IBM philosophy
operating system powering a
was well-documented and strongly
motor which was completely
unaffected by the booting, running ingrained in the culture. IBM's
philosophy covered its business
and closing down of a Linux
operating system on the same CPU. practices and how employees,
customers, and suppliers were to
be treated. The IBM prime
Source:
http://www.theinquirer.net/inquire directive, as it were, was to treat
everyone fairly, with respect and
r/news/2383946/imaginationbrings-virtualised-linux-security-to- dignity.
the-internet-of-things
Before I started working with
Submitted by: Arnfried Walbrecht
Linux in some depth, I had never
known that it had a philosophy. I
mean, what could a philosophy
actually do for an operating
system? After a bit of research, I
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discovered that all operating
systems have a philosophy. I also
learned that the philosophy of an
operating system matters.
Source:
http://opensource.com/business/1
4/1 2/linux-philosophy
Submitted by: Arnfried Walbrecht

LINUX FOUNDATION FINDS
ENTERPRISE LINUX GROWING
AT WINDOWS' EXPENSE

S

ure, Windows still rules the
desktop, but Linux kicks rump
and takes names on enterprise
servers and the cloud, according to
the 201 4 Enterprise End User
Trends Report from The Linux
Foundation and the Yeoman
Technology Group.
Specifically, they found that
enterprise server applications are
being deployed at the expense of
Windows and Unix over the last
four years. Linux application
deployments have risen during this
period, from 65 percent to 79
percent, while Windows
deployment has fallen from 45
percent to 36 percent.
This report is based on data

from an invitation-only survey of
The Linux Foundation's Enterprise
End User Council as well as
companies and organizations with
sales of $500 million or more, or
500 or more employees. The
surveyed group included Morgan
Stanley, Goldman Sachs, Bank of
America, Bristol-Myers Squibb,
NTT, Deutsche Bank, DreamWorks,
ADP, Bank of New York, NYSE,
NASDAQ, Goodrich, MetLife, and
AIG. Of course, these companies
are already invested in Linux. That
said, it's noteworthy how many
Fortune 500 and financial
powerhouses now put their trust in
Linux for mission-critical software.
Source:
http://www.zdnet.com/linuxfoundation-finds-enterprise-linuxgrowing-at-windows-expense7000036365/
Submitted by: Arnfried Walbrecht

LITTLE KNOWN GUI
FIREWALL O PTIONS FOR
LINUX

the two, though, there can be a
learning curve. The good news,
however, is that there are many
graphical user interfaces (GUIs) you
can use with Linux. Let's look at
some of the most powerful yet
easy-to-use options available.

Torvalds' announcement also
says “I'd love to say that we've
figured out the problem that
plagues 3.1 7 for a couple of
people, but we haven't.”

Source:
http://www.serverwatch.com/serve
r-tutorials/little-known-guiSource:
firewall-options-for-linux.html
http://www.theregister.co.uk/201 4
Submitted by: Arnfried Walbrecht /1 2/08/linus_torvalds_releases_lin
ux_31 8_as_31 7_wobbles/
LINUS TORVALDS RELEASES Submitted by: Arnfried Walbrecht

LINUX 3.1 8 AS 3.1 7
WOBBLES

L

inus Torvalds has pressed the
go button for a new release of
his eponymous kernel.
Linux version 3.1 8 was let loose
on Sunday, US time, after what
Torvalds wrote was a “tiny” patch
to get release candidate 7 done.

The new version's headline
features for business users are
better sleep and resumption for
s you may know, IPtables and Linux servers, more support
NetFilter combine to make the (thanks to a contributor from
most popular firewall solution in
Samsung) for the The FlashLinux. Given there's only a native
Friendly File-System (F2FS) and
command-line interface (CLI) for
some RAID-friendly tweaks to
full circle magazine #92
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BTRFS. There's also lots more
support for graphics devices from
NVIDIA and AMD.

POWERFUL, HIGHLY
STEALTHY LINUX TROJAN

MAY HAVE INFECTED VICTIMS
FOR YEARS

R

esearchers have uncovered an
extremely stealthy trojan for
Linux systems that attackers have
been using to siphon sensitive data
from governments and
pharmaceutical companies around
the world.
The previously undiscovered
malware represents a missing
puzzle piece tied to "Turla," a socalled advanced persistent threat
contents ^
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(APT) disclosed in August by
Kaspersky Lab and Symantec. For
at least four years, the campaign
targeted government institutions,
embassies, military, education,
research, and pharmaceutical
companies in more than 45
countries. The unknown
attackers—who are probably
backed by a nation-state, according
to Symantec—were known to have
infected several hundred Windowsbased computers by exploiting a
variety of vulnerabilities, at least
two of which were zero-day bugs.
The malware was notable for its
use of a rootkit that made it
extremely hard to detect.
Source:
http://arstechnica.com/security/20
1 4/1 2/powerful-highly-stealthylinux-trojan-may-have-infectedvictims-for-years/
Submitted by: Arnfried Walbrecht

SKINNY U BUNTU LINUX
'SNAPPED' UP BY FAT
M ICROSOFT CLOUD

A

smartphone-inspired version
of Ubuntu Server for Docker
minimalists has been revealed with
initial backing from Microsoft.

Canonical is today expected to
unveil the "Snappy" version of
Ubuntu Core, a stripped-down
server image of just 1 1 0MB built
for thousands of servers in the
cloud. It is available as an Alpha
preview. The minimalist root file
system is built solely for
transactional jobs and applications
and will début on Microsoft’s
Windows Azure.

HP' S B IG SLAP I N THE
FACE TO M ICROSOFT WILL
SHOW U P N EXT YEAR

B

y next June, HP will be
showing off what it hopes will
become the future of the
operating system. And it won't
have anything to do with Microsoft
or Windows. The operating system
is called Linux++, and it is part of
The slimmed-down Linux system HP's ambitious project to reinvent
is promised for other clouds before the computer, reports MIT
Christmas. Canonical told The Reg Technology Review's Tom
Simonite.
Microsoft has proved very
proactive in supporting Ubuntu
Ultimately, HP hopes to replace
Core – it's willing to get Linux
Linux++ with something even more
workloads up and running on its
cloud. Canonical believes Microsoft radical and homegrown, an
operating system called Carbon,
is a ready market and suited to
though it hasn't announced a
Ubuntu, given its large enterprise
timeline for that. This is all part of
customer base. The Linux firm
HP's plans to build "The Machine,"
expects that plenty of enterprise
a computer so radical and so
jobs will now be run on Linux
powerful that it will reduce today's
through the medium of Windows
data center down to the size of a
Azure.
refrigerator.
Source:
http://www.theregister.co.uk/201 4 Source:
http://uk.businessinsider.com/hp/1 2/09/ubuntu_core_snappy/
Submitted by: Arnfried Walbrecht will-show-off-new-linux-os-in-201 5201 4-1 2?r=US
Submitted by: Arnfried Walbrecht
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U.S. M ARINE CORPS WANTS
TO CHANGE OS FOR RADAR
SYSTEM FROM WINDOWS
XP TO LINUX

W

hen it comes to stability and
performance, nothing can
really beat Linux. This is why the
U.S. Marine Corps leaders have
decided to ask Northrop Grumman
Corp. Electronic Systems to change
the operating system of the newly
delivered Ground/Air TaskOriented Radar (G/ATOR) from
Windows XP to Linux.
It's interesting to note that the
Ground/Air Task-Oriented Radar
(G/ATOR) was just delivered to the
U.S. Marine Corps, but the company
that built it chose to keep that
aging operating system. Someone
must have noticed the fact that it
was a poor decision and the chain
of command was informed of the
problems that might have
appeared.
Source:
http://news.softpedia.com/news/U
-S-Marine-Corps-Want-to-ChangeOS-for-Radar-System-fromWindows-XP-to-Linux466756.shtml
contents ^
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Submitted by: Silviu Stahie

M AJOR NVIDIA STABLE
D RIVER RELEASED

A

fresh NVIDIA driver for the
Linux platform has been
released and it looks like the devs
have a made number of changes
and important improvements that
really stand out.
NVIDIA seems to be the only
company that takes the Linux
community seriously, or least this
can be deduced from the
changelogs and the number of
drivers that are released for the
platform. AMD and Intel do their
share of work with the kernel, but
it's nowhere near the kind of
dedication that NVIDIA has. The
simple fact that they release often
is proof that they really do care
about their users.

O PERA 26 RELEASED.
I NSTALL IT ON LINUX M INT
1 7.1 AND U BUNTU 1 4.1 0

ELIVE OS I S A U NIQUE
D EBIAN AND
ENLIGHTENMENT COMBO

YEAR END CORE APPS
H ACK D AYS ANNOUNCED
FOR U BUNTU TOUCH

I

E

C

So, surprised I was when I read
that Opera 26 has been released
for Windows, Mac and Linux. Even
more surprising is this line from the
FAQ about Opera Linux: “Yes, all of
the major features found in Opera
for Windows and Mac are also
available to Linux users, including:
Speed Dial, the Discover feature,
Opera Turbo, bookmarks and
bookmark sharing, themes,
extensions and more.”

Elive is a different kind
operating system and it will require
the user to be a little open-minded
because this distro provides an
interesting desktop experience.
There are very few OSes out there
that even share the same kind of
desktop, so it's easy to say that it
provides something unique.

Native apps are what Ubuntu
Touch needs more than anything
and that's because the team can
only deal with the operating
system, but the rest of the
ecosystem has to come from thirdparty developers who need to take
the rest of the journey.

don’t quite remember the last
time I used Opera browser, but
it’s been a very long time ago. I
didn’t even think that the company
is still developing a Linux version.

Source:
http://www.linuxbsdos.com/201 4/
1 2/04/opera-26-released-install-itSource:
on-linux-mint-1 7-1 -and-ubuntu-1 4http://news.softpedia.com/news/M 1 0/
ajor-NVIDIA-Stable-DriverSubmitted by: LinuxBSDos
Released-466755.shtml
Submitted by: Silviu Stahie
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live, a Linux distribution based
on Debian that uses the
Enlightenment desktop
environment to provide a unique
user experience, is now at version
2.4.6 and the developers are
getting closer to a stable release.

The Enlightenment DE is mostly
responsible for this, but it's also
the devs merit who managed to
make all the necessary changes to
turn this into something special.
Source:
http://news.softpedia.com/news/El
ive-OS-Is-a-Unique-Debian-andEnlightenment-Combination466754.shtml
Submitted by: Silviu Stahie
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anonical is looking to improve
the core apps that are already
available for Ubuntu Touch and is
organizing a new Core Apps Hack
Days event that should galvanize
the efforts of more developers
towards this platform.

The guys and gals who build
Ubuntu Touch do provide a number
of apps, like the Gallery or the
Browser, but they can't spread
their efforts in all the directions.
This is where Core Apps Hack Days
comes into play.
Source:
http://news.softpedia.com/news/Y
ear-End-Core-Apps-Hack-DaysAnnounced-for-Ubuntu-Touch466699.shtml
Submitted by: Silviu Stahie
contents ^
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D OTA 2 RUNS N ATIVELY ON D ROPBOX 3 FOR LINUX
M IR WITH THE SAME
G OES STABLE WITH N EW
PERFORMANCE AS X1 1
Q T UI, SETUP WIZARD

WHY IS THE N UMBER OF
LINUX D ISTROS D ECLINING ?

T

http://www.datamation.com/opensource/why-is-the-number-of-linuxdistros-declining.html
Submitted by: Arnfried Walbrecht

he number of Linux
distributions is declining. In
anonical has been working on
he “problem” with new
201 1 , the Distrowatch database of
the Mir display server for some
releases of Dropbox is that
active Linux distributions peaked at G REEN H ILLS CHALLENGES
time, although most of their
most are virtually identical to the
323. Currently, however, it lists
“RUDIMENTARY” LINUX
efforts have been made towards
last. While good in that no
only 285. However, exactly why the DEBUG
the mobile platform. They are now senseless changes arrive solely for decline is taking place and how
looking to optimize it for desktop
change’s sake, it’s bad in that it
much it matters remains unclear.
reen Hills Software has
use and nothing reflects the
makes for very droll “news”
announced a software
progress made more than a famous coverage!
Distros have always come and
development environment for
game running on Mir.
gone. In fact, Distrowatch lists 791 embedded Linux developers.
Thankfully this release does
distributions that have existed
Mir is already working on the
have a bit more meat on its free
since it was founded in 2001 ,
According to Green Hills, the Linux
desktop, but users need to have
range bones. As we showed you
although less than forty percent
development software in its MULTI
the open source video drivers in
back in July, the UI changes in
have ever been in active
tool suite will address the
order to make it work. Canonical
Dropbox 3.0.x are noticeable —
development at any given time.
has recently built a new flavor
and not just because the blue panel These tallies may not be complete, “rudimentary” state of many
debuggers for Linux, which it said
called Ubuntu Next which features icon is now white! ;)
since some distributions probably
were “difficult to learn, setup, and
Unity 8 and the Mir display server.
never register with Distrowatch,
use and lack the powerful control
The new desktop environment
Another change making the
but they are as accurate as anyone and visibility that modern
needs Mir, so it stands to reason
jump from the July preview is the
is likely to offer.
electronic systems demand”.
that the updated DE will arrive for all-new setup wizard. Nothing too
regular users when Mir is also
fancy here, but a big reduction in
But until about 201 1 , the
Green Hills said it is possible
ready. It's not there yet, but it's
the number of hoops one jumps
number of active distributions
with
MULTI to control and debug
taking great strides.
through on a fresh install.
slowly increased by a few each
all aspects of an embedded Linux
year. By contrast, the last three
system, including the Linux kernel,
Source:
Source:
years have seen just a 1 2% decline kernel threads, user mode threads
http://news.softpedia.com/news/D http://www.omgubuntu.co.uk/201 -- a decrease too high to be likely to
and processes, and interrupt
ota-2-Runs-Natively-on-Mir-with4/1 2/dropbox-3-0-3-stable-linuxbe coincidence. So what's
service routines (ISRs), all from a
the-Same-Performance-as-X1 1 desktop-build-released
happening?
single tool, in a single window or in
466662.shtml
separate windows per instance.
Submitted by: Silviu Stahie
Source:

C

T

G
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Source:
http://www.electronicsweekly.com
/news/design/eda-and-ip/greenhills-revamps-linux-debg-201 4-1 2/
Submitted by: Arnfried Walbrecht

THE ' GRINCH ' ISN ' T A LINUX
VULNERABILITY, RED H AT
SAYS

Policy Kit (Polkit), which was
designed to aid users in installing
and running software packages.
Red Hat maintains Polkit, an opensource program. By allowing users
to install software programs, which
usually requires root access, Polkit
could provide an avenue to run
malicious programs, inadvertently
or otherwise, Alert Logic said.

T

But the system was designed to
he "grinch" Linux vulnerability work that way -- in other words,
grinch is not a bug but a feature,
that Alert Logic raised alarms
about Tuesday is not a vulnerability according to Red Hat.
at all, according to Red Hat.
Source:
http://www.computerworld.com/ar
"This report incorrectly
ticle/2861 392/security0/theclassifies expected behavior as a
grinch-isnt-a-linux-vulnerabilitysecurity issue," said a Red Hat
red-hat-says.html
bulletin issued Wednesday,
responding to Alert Logic's claims. Submitted by: Arnfried Walbrecht
Security firm Alert Logic
Tuesday claimed that grinch could
be as severe as the Heartbleed bug
and that it's a serious design flaw
in how Linux systems handle user
permissions, which could allow
malicious attackers to gain root
access to a machine.
Alert Logic claimed that an
attacker could exploit grinch
through the use of a third-party
Linux software framework called

YEAR OF THE PENGUIN:
A LINUX MOBILE IN 201 5?

to date.

interface.

At the same time the distro
that's closest to being a household
name, Ubuntu, has been nearly
silent since 1 4.04 arrived in April.

Editors note: The long awaited

To paraphrase author Charles
Dickens, the past year of Linux
releases has been both the best of
times and the worst of times.
At the very moment that Linux
desktops seem to be reaching new
levels of sophistication, polish and
"just works" ease-of-use, the entire
future of the desktop computer (by
which I also mean laptop) feels in
doubt.

Ubuntu Phone will be released to
insiders in early February 201 5. I
hope to have one for unboxing and
review by mid-February. Stay
tuned!
Source:
http://www.theregister.co.uk/201 4
/1 2/22/linux_year_review/
Submitted by: Arnfried Walbrecht

No, the desktop is not dead yet,
but it increasingly feels as though,
for the general use case anyway,
the mobile device offers most of
what the user needs.

A tablet may not be top of the
holiday wish list for self-professed
t's nearly impossible to sum up
power users, but for most it's
an entire year of developments
enough to check email, browse the
in something as large and nebulous web and upload some images.
as the world of desktop Linux,
Combine that with better battery
especially in a year like this one
life, smaller, lighter form factors
which has seen some the best
and you can understand why
releases that projects like Mint,
Canonical spent the better part of
Fedora and openSUSE have put out year working on its mobile
full circle magazine #92
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C O M M AN D & C O N Q U E R

L

Written by Lucas Westermann

WHAT IS FLEXBOX?

F l e xb o x & P yt h o n S c ri p t

tricks.com/snippets/css/a-guide-to- options: nowrap, wrap, wrapreverse - Function for Flexbox's
flexbox/ - Complete Guide to
flex-wrap
Flexbox is a new layout system Flexbox (CSS Tricks)
• flex-justify(value) value can be:
introduced in CSS3, and is currently
start, end, center, space-bottom or
supported in one form or another U SAGE
space-around - Function for
in most commonly used versions of
Flexbox's justify-content
Firefox, Chrome, Safari and Opera.
Just place the flexbox.styl file
It’s also supported by IE 1 0 & 1 1 .
into your project, then import it in • flex-content(value) value can be
the same options as for flexSee here for a thorough
your stylus file with @import
justify(value) - Function for
breakdown:
'flexbox' Each function tries to
Flexbox's align-content
http://caniuse.com/#search=flexbo accept as many official values
• flex-align(value) value can be:
x
(according to the Flexbox
start, end, stretch, center, baseline
Link:
standard), but does require some
- Function for Flexbox's align-items
https://github.com/lswest/flexboxFlexbox makes it easy to align
changes.
• flex-self(value) accepts start, end,
stylus
elements (vertically and
auto, center, baseline, stretch horizontally), as well as having
F
UNCTIONS
Function for Flexbox's align-self
grow/shrink according to
WHAT YOU ’LL FIND THERE elements
• flex-group(value) accepts any
the size of the parent. Best of all,
• flexbox(value) where value is
positive number - Function for
it’s possible to adjust the ordering either flex, or inline-flex.
• Folders with css and stylus files
Flexbox's order attribute
of elements in CSS alone. That
• a LICENSE file
• flex(size, grow, shrink, basis) Each • flex-firefox() Helper function for
means your left-handed sidebar
• Readme.md
value, except grow, is optional. Size legacy Firefox (where Flexboxes
can come after your content
• flexbox.html file
is used for a width attribute (for
were treated as inline items). Place
element on smartphones, instead
legacy browsers). To set only the
it inside the firefox-only selector
of being forced to work with floats grow value, use flex(grow: 1 ). The
The flexbox.html file and the
(@-moz-document url-prefix()). See
or display: none.
css folder are used only as an
same format can be used to set any the example.styl file for an
example. In the stylus folder, you’ll
specific arguments.
example.
see an example.styl folder, as well Links:
• flex-direction(value) value can be:
• http://theas a flexbox.styl file. The
row, row-reverse, column or
H OLIDAY B ONUS
flexbox.styl file is the only file you echoplex.net/flexyboxes/ - A tool
column-reverse - Function for
to
help
figure
out
your
flexbox
need to copy to use the functions.
Flexbox's flex-direction
settings.
And, due to the time of the
• flex-wrap(value) Accepts the 3
• http://cssyear, I have a useful little hint for
full circle magazine #92
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ast month, we talked about
Jeet, and I mentioned Stylus.
Since then, I’ve also started using
Flexbox on a few websites. After a
single website, I was tired of
writing all the vendor prefixes by
hand, and designed a Stylus file
containing functions to minimize
the amount of typing needed.
Once I got it to a point where I was
happy, I published it on github.

COMMAND & CONQUER
anyone who needs to send lots of
cards or letters using addresses in
your contact list. Once this issue is
released, it will admittedly be a bit
too late for Christmas cards, but
nonetheless...

This year my solution to this was
using Python to parse a csv
(comma separated value) file, and
output a .txt file containing
addresses in the format:
Name
Position
Company
Street
City ZIP Code
Country

import csv # library to handle reading csv files
with open(‘contacts.csv’, 'r', encoding="utf-8") as f: # open a file with UTF-8 encoding
(for german symbol support)
lines = csv.reader(f) # read the csv file
your_list = list(lines) # create a list from the csv file entries

addresslist = open('files/addresses.txt', 'w')
for item in range(1,len(your_list)):
name = your_list[int(item)][0]
position = your_list[int(item)][60]
companyName = your_list[int(item)][58]
address = your_list[int(item)][41] + "\n"
if any(c.isalpha() for c in your_list[int(item)][45]):
address += your_list[int(item)][42] +" " + your_list[int(item)][45] +"\n"
else:
address += your_list[int(item)][45] + " " + your_list[int(item)][42] +"\n"
address += your_list[int(item)][46]
addresslist.write(name + '\n')
if position != "":
addresslist.write(position + "\n")
if companyName != "":
addresslist.write(companyName + "\n")
addresslist.write(address + '\n\n')
addresslist.close() # close file

The only bit of information from
the csv necessary for this to work is
the position of the fields you want
to use in the address (i.e. if the
name field is the first one, it’s
and then write the necessary
position 0). You can save these in
sections to the addresses.txt file.
variables if you want to.
Once the file is created, you can
A rough outline (not a working
copy the text into another program
program) is shown top right.
to format it (or print it directly on
the envelopes or on labels).
This creates a list where each
element is another list containing
A complete copy of a working
the values of the fields for that line script can be found here:
of the csv file. In other words - it’s a http://pastebin.com/bZmanQAc.
two dimensional list. I iterate over The only changes necessary will be
the list using the following code,
to the index variables, according to
full circle magazine #92

the CSV file you want to
implement.
I hope this has been interesting
for at least some users - and
perhaps sending large numbers of
cards in the new year will be easier.
If you have corrections, questions,
comments, or suggestions, I can
always be reached at
lswest34+fcm@gmail.com.
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Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.
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M a ke A P D F S p e c i a l E d i t i o n

Written by Brian

Greg is feeling a bit under the
weather this month, but hopefully
he'll be well enough to return for
FCM#93.

W

ay back in FCM#82 in a
letter Arick wrote “On that
note, I'd like to see a compilation
for the GIMP articles. That was also
an exceptional series.”
You don't have to wait for a

compilation as you can make your
own quite easily. There are several
ways but, for this article, I've
chosen to use PDF Mod which is in
the repositories. Open Synaptic
and search for it there.

1 8, 1 9, 60, 61 , 62, 63, 83. I might
and highlight and extract them.
have missed some so double check.
If we now left-click our solitary
Open the first one in PDF Mod
page we can drag it across to
(shown below left).
where we want it.

Articles don't always allow us to
The next thing to do is to search select every page we want easily,
through the Index of issues to find so, in this case, right-click on the
which ones contain the articles you first page of the article and select
are interested in.
'extract'.

The final step is to rename our
first part of the compilation and
save it in a new folder – In this case
I've called it Grub1 a and saved it in
a Temp folder.

Issues containing GIMP-related
articles are 6, 1 2, 1 3, 1 4, 1 5, 1 6, 1 7,

If we now go back to our article
we can select the other two pages

The file that contained the
single page can now be closed

full circle magazine #92
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Finally save it as Collected GIMP
(shown below).
If you intend to use a collection
of articles, please abide by
copyright rules (CC-SA) as
published in the magazine (page 2)
each month.
Or, better still, send it to us
here at FCM and we'll host them on
the site for others to download.

without saving and we can move
on to extracting the next article.
I now have 1 4 files which I need
to make into one file, plus, it would
be nice to have a cover.

to the cover. The reason for
working backwards is that each file
is added before the existing files.

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some great
guests on the show, telling us
first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.
The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

It's easy to make a .pdf cover
page using either Scribus or
LibreOffice and it can be as simple
or complex as you wish.
Now open Gimp1 4 in PDF Mod
(shown above). This time we are
going to add the folders we
created previously.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

Click on the + symbol and add
each folder -- working back from 1 3

podcast.ubuntu-uk.org
full circle magazine #92
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Written by Elmer Perry

hen you begin to create
formulas in Calc, you soon
realize that the wrong kind of data
in a cell referenced by your formula
can throw the results off. Calc does
its best to interpret the data
entered according to the
formatting style of the cell. If you
format the cell as a date type, Calc
does its best to translate the input
in that cell as a date. At times it is
successful and other times not.
Fortunately, Calc comes with
validity options built in to help you
design your spreadsheet in such a
way as to give the user help with
the input or even force them to
enter the data type needed for the
cell. In this article, we will look at
the validity options and its
capabilities.

Li breO ffi ce Pt.44 - Va li d a ti n g D a ta i n Ca lc
become a crosshair. Drag down to
A9. When you release mouse
button, the rest of the weekday
names are filled in. This happens
We will start by creating our
title and column headers. In cell A1 , because the days of the week are
enter “Time Sheet”. On row 2, fill in one of the default sort lists. You
can see all the lists and add your
columns A-F with the following
own at Tools > Options >
titles: DAY, IN, OUT, IN, OUT,
TOTALS. Now for the row headers. LibreOffice Calc > Sort Lists.
In cell A3, type in “Sunday”. Making
Now let's format the cells.
sure that cell A3 is highlighted,
Select B3:E9, right-click, and select
click on the small square in the
Format Cells. Click the Numbers
lower right corner of the
tab. From the Category list box,
highlighted cell. The cursor will
time input must have a greater
value than the previous entry.

If you haven't yet, you might
want to save your sheet.

SETUP VALIDATION

SHEET SETUP
Before we get to the validity
options of Calc, we need to set up
a spreadsheet where we will use
the options. The spreadsheet is a
time sheet for showing the hours
worked during a week. The time
sheet works well for our example
because on a given day, the next

select Time. If you normally use a
1 2-hour clock, select the “01 :37
PM” option under format.
However, for a 24-hour clock,
select “1 3:37.” Click OK to save the
options. Column F is the totals. We
will need to select a time format, at
least for the last one, that can go
beyond 24 hours. Select cells
F3:F1 0, right-click, select Format
Cells. Again, on the Numbers tab,
select the Time category, but for
the format, select “87661 3:37.”
This will allow for totals that are
greater than 24 hours. Click OK to
save the settings.

We will need to check the
validity of the time inputs. We will
want them in a Calc-acceptable
time format. This is the only
requirement for valid data in the B
column. For the other columns (CE), we will need to also make sure
the input is greater than the input
before it.
full circle magazine #92
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Select cell B3, then Data >
Validity. The Validity dialog will
appear.
The Criteria tab (above) is
where we control what constitutes
valid data. The Allow drop-down
list defines the type of data that is
acceptable. The default is All
Values. The other types are Whole
Numbers, Decimal, Date, Time, Cell
Range, List, and Text Length. The
choices for the different types are
basically the same except for Cell
Range and List. With the cell
Range, you define a cell range and
the cell must contain a value that is
in one of those cells. The defined
range must consist of only one
column or one row. With the List
option, you define a list of
acceptable values. With both the
List and Cell Range options, you
get a drop-down list box with the
acceptable values. For our

purposes, we need Allow set to
Time.
Check the box for “Allow empty
cells” to allow cells to remain
empty. This will allow us to start
with a blank time sheet.
The Data drop-down list allows
you to select the comparative
operator to use for this validation.
The choices are equal, less than,
greater than, less than or equal to,
greater than or equal to, not equal,
valid range, and invalid range. Each
one asks for a minimum, maximum,

full circle magazine #92

or value to compare, except for the
two range choices. The range
choices require a minimum and
maximum. For our purpose, we
need the greater than operator. In
the minimum text box, enter 1 2:00
AM or 00:00.
Click on the Input Help tab
(below). The settings on this tab
are optional. The idea is to provide
the user with information about
what to enter into the cell as a tip

15

box that pops up when the cell is
selected. To activate, click the
checkbox for “Show input help
when cell is selected.” Create a
title for the tip box by typing it in
the Title text box. For us, we could
use the title “Start Time”. The Input
Help text box is where you put the
actual help tip like “Enter the start
time: ex. 1 :00 PM or 1 3:00”.
Switch to the Error Alert tab
(above). Here we can set the
validation to display a message
when invalid data is entered. To
activate the setting, check the
checkbox for “Show error message
when invalid values are entered”.
There are four choices for the
Action drop-down list, Stop,
Information, Warning, and Macro.
Stop, the one we will use, prompts
with a dialog and rejects the input
contents ^
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when invalid data is entered. For
Information and Warning, they
prompt with a dialog containing
OK and Cancel buttons when
invalid data is entered. If the user
clicks OK, the input is left as it is. If
the user clicks Cancel, the input is
rejected. Macro will allow you to
select a macro to run when invalid
data is entered. The Title and Error
Message is the title and message
for the dialog box. We could set
them to “Invalid Time” and “Enter
in time format: 1 3:00 or 1 :00 PM”.

minimum value to B3. Notice that
we use a relative cell reference
here. This will allow us to copy it to
the other cells and have the
reference translate. These criteria
tell Calc that the cell requires a
value greater than the value in cell
B3. Do what you want with the
help and error tabs. I do
recommend using at least
Information or Warning messages
for invalid data. The messages
could mention needing a greater
value (or a later time). Right-click
cell C3 and copy the cell, then
Once you have everything set,
paste it into cells C4:C9.
click OK to save the Validity dialog
You can repeat for columns D
settings.
and E. You can also just copy C3 to
D3:D9 and E3:E9, but you will need
We will copy cell B3 to cells
to adjust the text in the dialogs for
B4:B9. Right-click cell B3 and select help and error.
Copy. Select cells B4:B9, right-click,
and select Paste. This will copy the TOTAL F ORMULAS
validity settings to the cells. The
whole column will have the same
Now that we have our
requirements for input.
validation set up, we need to
create the formulas to give us our
For columns C, D, and E, we will totals. We will start with the daily
do almost the same thing. We will totals. Select cell F3. Enter the
go through the steps on C, and you formula
can repeat for D and E. Select cell
C3, Data > Validity. On the Criteria =(C3-B3)+(E3-D3)
tab of the Validity dialog, select
Time from the Allow drop-down
which will give us the total for
list. Check to allow empty cells. Set Sunday's times. Right-click F3 and
Data to greater than, and set the
full circle magazine #92

Copy. Select cells F4:F9, right-click,
and Paste.
For the weekly total in F1 0, we
will just sum the daily totals. Here
is the formula:
=SUM(F3:F9)

PROTECT CELLS
Once you have a sheet set up
the way you like, you may want to
protect the parts of the sheet you
don't want changed like the labels
and formulas. First, you need to tell
Calc whether the cell is protected
or not. Then you add protection to
the sheet or document once
everything is finished. In the case
of our time sheet, we need to
protect everything except for the
cells where the user enters their
times, B3:E9.

By default, the Protect option is
turned on for all cells. To change
the protection setting for the input
cells, select B3:B9, Format > Cells,
and the Format Cells dialog
appears. Click on the Cell
Protection tab and uncheck
Protected.
At this point, you can still edit
any cell because the sheet or
document is not protected. To turn
on protection for the sheet or
document, Tools > Protect
Document > Sheet (or Document).
The Protect Sheet or Protect
Document dialog will appear
depending on which option you
selected. Enter and confirm a
password in the dialog. The options
will allow you to check whether the
user can select protected or
unprotected cells. If you do not
enter a password, then no
password is required to remove
protection from the sheet or
document.
To remove protection from a
sheet or document, Tools > Protect
Document > Sheet (or Document).
If a password was used when
protection was set, enter the
password used to protect the
sheet or document.
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way you want it, you can protect
the sheet from unwanted changes.
This is a good way to protect
formulas and labels. Finally, the
Detective tool allows the user to
mark invalid data they entered.

EXTRA! EXTRA!
READ ALL ABOUT IT!
M ARK I NVALID D ATA WITH
D ETECTIVE
If you selected Warning or
Information from the Action dropdown list in the Validity dialog, a
user could enter invalid data and
click OK to keep the invalid input.
This may generate strange results
in your totals or an error. Tools >
Detective > Mark Invalid Data will
mark the invalid data. Once the
user corrects the data, Tools >
Detective > Mark Invalid Data
should clear the marks, unless the
data is still invalid. Notice from my
sample that invalid data can cause
other cells data to show as invalid.

The Calc Validity options are a
great way to set up sheets for use
by other people, or to keep you
from entering invalid data on a
complicated sheet. You can set it
up to reject the invalid data
outright, or for the user to make a
choice about keeping the input.
Once you have the sheet set the

Elmer Perry's history of working, and
programming, computers involves an
Apple ][E, adding some Amiga, a
generous helping of DOS and
Windows, a dash of Unix, and blend
well with Linux and Ubuntu.
He blogs at
http://eeperry.wordpress.com

Our glorious news reporters
are now posting regular news
updates to the main Full Circle
site.
Click the NEWS link, in the site
menu at the top of the page,
and you'll see the news
headlines.
Alternatively, look on the right
side of any page on the site,
and you'll see the five latest
news posts.
Feel free to discuss the news
items. It's maybe something
that can spill back from the site
into the magazine. Enjoy!

full circle magazine #92
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L

N a u t i l u s Ac t i o n s T o B u l k P ri n t

Written by Alessio Ciregia

The most elegant solution that I
et's suppose that you have a lot
have
found, consists in the use of a
of ODT (Libreoffice Writer)
software named Nautilus-Actions.
files, and you need to print them
As stated by the “apt-cache show”
all.
command: Nautilus actions is an
extension for Nautilus, the GNOME
Opening each file and clicking
on the Print icon could be the right file manager. It allows the
way if the files are three or at most configuration of programs to be
four, but what if you have twenty, launched on files selected in the
Nautilus interface. Obviously
fifty, hundreds of files to print all
Nautilus-Actions is not limited to
at once?
bulk printing.
If you are a command-line lover,
With such software, you can
probably there is not any problem.
easily create entries in the context
In fact you can invoke a command
menu that appears when you rightlike the following, maybe from
click on a file in the Nautilus file
inside a loop:
manager.
for file in *
do

Let's go back to our goal:
configure a context menu entry
that directly prints a Libreoffice
Writer file without the need to
open it.

related icon).
In the “Action” folder, define a
“Context label”, let's call it “Print”.

First of all, you need to install
the package (using apt-get or the
Ubuntu software center or
Synaptic):
sudo apt-get install
nautilus-actions

Now launch the program. An
intuitive and self explanatory
interface should appear.
Now go to “File” and select
“New action” (or click on the

libreoffice --pt
[printer_name]
file_to_print.odt "$file"

In the “Command” folder, then
in the “Command” section, fill in
the “Path” field with the path to
the Libreoffice executable:
/usr/bin/libreoffice

done

But if you are afraid of the
command-line, or if you want to
allow a dummy user to print a
bunch of files, the solutions could
be more than one, as usual.
full circle magazine #92
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In the “Parameters” field, put
the libreoffice parameter “--pt”
(followed by the optional printer
name to use if you don't want to
print on the default one).

Let's save, exit from the
program, and open the directory
containing the bunch of ODT files.
You can select just one file just
to test, or even all the files, then
you must right-click with the
mouse, and a new entry should be
in place: Print.

Now, if you don't want to show
the “Print” context menu on all the
kinds of files, you must use a filter
on the file name (more precisely on
If you select a file that doesn't
the extension) or on the MIME
have the “.odt” extension, the
type. Here we will use the file
custom context menu entry should
extension, just to keep things
not appear.
simple.
In the “Basenames” folder,
delete the default entry (by way of
the “-” icon), and add (by way of the
“+” icon, of course) a filter: “*.odt”
as the Basename filter, and click on
the “Must match one of” radio
button. In this way, the Print menu
will appear only for the files
containing the “.odt” at the end
(commonly known as the file
extension).

PYTHON SPECIAL EDITIONS:

http://fullcirclemagazine.org/issue-py01 / http://fullcirclemagazine.org/issue-py02/

The above configuration is
somewhat simplistic, we will not
dive into a more advanced
configuration.
However there are many
possibilities. For instance you can
associate an icon to your action,
you can define a context menu
entry only for certain folders, or
you can create an entry with many
subentries.

full circle magazine #92

http://fullcirclemagazine.org/pythonspecial-edition-issue-three/

http://fullcirclemagazine.org/pythonspecial-edition-volume-four/

http://fullcirclemagazine.org/pythonspecial-edition-volume-five/

http://fullcirclemagazine.org/pythonspecial-edition-volume-six/
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I n ks c a p e - P a rt 3 2

Written by Mark Crutch

Let's start with a familiar image
to which we'll apply a clipping path.
Remember, all the parts inside the
bright green clipping line will
remain visible once the clip is
applied, whereas those outside it
will be hidden.

second time and clip it to show the
hands. Now we have two images,
Erratum : During magazine layout,
each clipped differently, resulting
it's common for images to be
in two separate objects that can be
cropped or dropped entirely.
modified independently. With a
Unfortunately, that happened to a
linked image, that might be a
couple of the images in last
reasonable approach, but if our
month's article which may have
images are being embedded so
caused confusion – some of the
Having clipped our image down that the resultant SVG can be
cropped parts were directly
shared more easily, we've now got
referenced in the text. I've put the to just show her head, what if we
then
decide
we
also
want
the
two large bitmap images bloating
full images online at
hands? We could release the clip
our file. What we really want is a
http://www.peppertop.com/fc/
and construct a more complex path way to include the image just once,
that includes the hands as well,
but create two completely
before
re-clipping.
But
that
still
separate clips from it.
ack in part 29, I showed one
use for putting a single object leaves us with a single object, with
the head and hands at a fixed
From the introduction, you've
into a group: as the start of a
method for producing mirrored or distance apart. If we want to move probably already deduced that the
the hands independently of the
answer is to group our image
kaleidoscopic drawings using
clones. This time, I'm going to use a head – or maybe scale or rotate
them – we're out of options.
single object in a group, plus a bit
of cloning, to perform some sneaky
The next obvious approach
tricks with clipping and masking.
would be to import the image a

B
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before clipping it. Here I've
denoted the group with a dotted
box for illustrative purposes – it
doesn't appear in a real drawing.
The result (below right) doesn't
look altogether different from our
first attempt, but that's because
the effect is not a visual one, but
rather a structural one. Previously,
our clipping path was applied
directly to the image. If you were
to look in the XML Editor you
would see that the image has “clippath” attribute whose value is the
ID of a path stored in the <defs>
section of the XML file. With the
image grouped and then clipped,
however, the clip-path attribute is
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now on the group itself and the
image either has no clip-path
attribute at all, or its value is set to
“none”.

“window”, but that still doesn't get
us two separate clips. For that we
need to get a little devious.

Step 2 : Group the image. An

Step 6: Clone the image using

Edit > Clone > Create Clone, or by
pressing ALT-D. Note in the XML
Editor that an <svg:use> element is
The steps we'll be taking aren't
created with an “xlink:href”
The difference is subtle, but
difficult, but they do need to be
Step 3: Draw your clipping path. attribute that references the image
useful. By clipping the group, we've done in the right order. Once
by its ID. That's your clone! No
You should see it appear in the
effectively created a window
you've done it a few times, it will
matter how complex the parent
XML Editor as a sibling of the
through which we're viewing just a become second nature to you. To
object is, a clone is actually always
group.
part of the image at any time, but
make things clearer, I suggest
just a simple little <svg:use>
the image itself is still the full size. starting with a new file, and
Step 4: Select both the path and element that holds a reference to
We can demonstrate this by
opening the XML Editor so that you the group, then apply the clipping the original.
double-clicking to enter the group, can see exactly what's happening
path using either Object > Clip >
then dragging the image around.
at each step in the process.
Set, or by selecting “Set clip” from
We're moving the un-clipped image
the right-click context menu. Note
inside the clipped group, not
Step 1 : Drag and drop your
the effect in the XML Editor: your
moving the group itself, and the
image into the document. I chose
path is moved into the <svg:defs>
effect is quite different. You could to embed the image to really prove section, and the group gains a “clipalso scale, rotate or skew the
the point, but linking works as well. path” attribute that references the
image if you want, all without the
In the XML Editor you should see
path by its ID.
size or shape of the “window”
an <svg:image> tag with an
being affected.
“xlink:href” attribute. If you've
Step 5: Double-click to enter
embedded the image, then the
the group, and select the image.
It's a useful trick in its own right attribute will contain a Base64
Step 7: Currently you have an
Keep an eye on the status bar to
– combined with performing an
encoded version of the image's
confirm what's happening, and the image, and a clone of that image,
“object to path” on your clipping
binary content (if you linked the
both inside a single group. Let's
XML Editor should also highlight
path before the clip is applied (see image it will contain the path to the the image's entry.
put the clone somewhere more
Part 1 3) the simple expedient of
original image).
useful. With the clone selected, use
grouping your image before
Edit > Cut or CTRL-X to remove it
clipping means that you can not
from the document (watch it vanish
only change the clipping path itself
from the XML Editor before your
without releasing it, but you can
very eyes), and put it on the
also move the focal point of the
clipboard. Remember, what we've
content within it. Clearly you could
actually put on the clipboard is just
move the image like this to bring
a small <svg:use> element, not the
the hands into view through the
heavyweight binary data of the
full circle magazine #92
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XML Editor – expand it out to see
that your image is still inside it.

HOWTO - INKSCAPE
original image.

Step 8: Inkscape doesn't really

care where we paste the clone, so
long as the ID it references still
exists in the document. So doubleclick on the background until the
status bar tells you you're out of
the group, then use Edit > Paste or
CTRL-V to paste the clone into the
document.

Step 9: If everything went well

you should now be looking at
another, un-clipped copy of your
image. Remember, the clip was
applied to the group, but we've
taken our clone from a lower level,
before the clip has been applied,
giving us access to the original
image again but without requiring
a second copy of all that binary
data.

rotate, skew or blur it, and much
more besides. So let's complete our
original task, and clip it to show
just the hands.

that is, itself, clipped or masked.
And don't forget that layers are
just groups with some extra
metadata. There's nothing to stop
you cutting a clone to the clipboard
There you have it – two
(even one that's not in a group),
different clips of the same image,
then switching to a different layer
with just a single copy of the binary before pasting.
data embedded into your
document. Of course you don't
Don't think that this technique
have to stop at two copies, you can is limited to bitmaps either. As you
add as many clones as you like.
know, any Inkscape object or group
Each one only adds a tiny amount
can be cloned, and equally any can
to the document size, but gives you
a complete copy of the original
image to work with.
Although I've demonstrated this
technique with clipping, it works
equally well with masking, allowing
you to use all the fine control over
opacity that masking provides (see
Part 1 4 for more details). You can
even mask some clones whilst
clipping others to produce
something like this information
sheet that uses only a single
embedded image.

be put into a group. So you could
As I mentioned in step 8,
draw a complex character or scene,
Inkscape doesn't really care where group it (let's call that “Group 1 ”),
you paste the clone. In the
then group it again (“Group 2”).
Step 1 0: There's nothing special examples above I've simply pasted Clip or mask Group 2 and you can
about this clone – you can treat it
it outside of the original group, but still enter the group, clone Group 1 ,
as you would any other. That
you could also paste it into a
cut it to the clipboard, and use it
means you can clip, mask, group,
different group entirely – even one elsewhere in your drawing.
full circle magazine #92
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I use this technique a lot when
creating comic strips. Typically I
add some movement to a comic by
zooming or panning the scene
between frames, but rather than
copy or redraw the background and
characters I usually use clones that
are then scaled as necessary before
being clipped to fit in the frame.
With this approach, any changes to
the originals are automatically
propagated to the clones, so I don't
need to update multiple panels
each time there's a tweak to be
made. This strip, for example, really
consists of only one panel (the top
one), with the background being
cloned and clipped to create the
second two panels, and the heads
added in different poses on top to
introduce a little more variety.
Finally the text was added in a
separate layer to produce the
finished comic.
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Ard u i n o

Written by Ronnie Tucker

his month I begin creating a
project that may well come in
useful, and practical! My dad has
just bought some chickens and
wants an automatic way to open
and close a coop (sliding) door
when it gets light or dark. Enter the
Arduino!
Rather than dismantle my
precious laser trip wire, I’m using
one of several Arduino Nano’s that
I bought from China via eBay. They
were only a couple of pounds each,
and do the exact same job as the
Arduino Uno, except they need to
be mounted on breadboard or
veroboard as they have no sockets
for wires, only bare pins.
So, basically what I need is to
pull a wire (to open the sliding
door) when it gets daylight and
release the wire (to close the door)
when it gets dark. That means I
definitely need a servo, a 1 00uF
capacitor, a light dependent
resistor (LDR with a 1 0k ohm pulldown resistor), and I’ll probably use
a couple of LED’s (one red, and one
green with a 220 ohm pull-down
resistor each) to signal the door

status.
My main problems thus far are:
• the servo is always on when the
door is open. I need to find a way
to hold the wire but stop the servo
from whirring as it will inevitably
burn out the servo.
• the day/night settings are
hardwired into the code. It’d be
nice if there was maybe a pot to
adjust the settings
The code (at:
http://pastebin.com/wNMaXNkC)
isn’t too complex. Pre-setup(), I’m
initialising the servo, my settings
for sun-up and sun-down (for the
LDR), the servo angle for the door
open/closed, and the pins for the
LEDs.
The setup() is assigning the
servo pin number and setting it to
zero, gives the pin modes for the
LEDs (and what to initially set them
at), and then uses the serial port so
that I can get the LDR values.

then check to see IF the light is
near the sun-up value, and, if it is,
to open the door, turn the red LED
on, the green LED off, and delay for
two seconds. Same idea, but in
reverse, for sun-down.
I’ll keep you updated as to
whether I can fix the servo
problem, or if I move onto a new
project next month.
Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.

My loop() is to read the LDR,
full circle magazine #92
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W ri t e F o r F u l l C i rc l e M a g a z i n e

Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

document.

REVIEWS

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

G AMES/APPLICATIONS

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc). • Do not use tables or any type of
bold or italic formatting.

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the

Official Full Circle Style Guide :

http://url.fullcirclemagazine.org/75
d471
• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

If you are writing a review,
please follow these guidelines :
When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you access
to the raw text to translate from.
With a completed PDF, you will be
able to upload your file to the main
Full Circle site.
full circle magazine #92

When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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Get 25% off any SpiderOak package
with the code: FullcirclemagFans
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Written by Alan Ward

n the last installment of our
series, we went through a case
study in which we configured,
compiled and installed a bespoke
kernel for the eeePC. This small,
lightweight but quite outdated
notebook still can be actually
useful from time to time. However,
its Celeron M Pentium III-based
processor can benefit from a
kernel that has been slimmed up by
removing unneeded features, and
compiled using the complete
Pentium-III instruction set to make
best use of available hardware.
In this episode, we will start
hacking the kernel code itself, by
making small changes in the source
code and seeing what comes out of
it. To start with something simple,
but that can help give us some
insight into the kernel source code
internals, we will make some
simple changes in the /proc filesystem. This also has the
advantage of introducing the
reader into one of the most used
mechanisms that tell the system
user about what is happening
within the kernel.

THE PROC FILESYSTEM
We have already used the /proc
virtual file-system in episode 3,
“Configuring, compiling and
installing the kernel” of this series,
when we dumped file
/proc/version_signature to see
which exact kernel version we are
running:
$ cat /proc/version_signature
Ubuntu 3.13.0-24.47-generic
3.13.9

C o m p i l i n g A Ke rn e l - P a rt 5
defined in source directories
fs/ext4, fs/btrfs, or similar.
In the case of /proc, the same
data structures are built up in
kernel memory, but without
actually replicating an existing
structure on disk. This is why they
can be considered a virtual file
system, since they retain the very
same type of structure based on
inodes as in a regular file system,
but without accessing any data.
Instead of which, the kernel will
populate the (virtual) files with
data from the kernel itself when
files are accessed.

To elaborate on this, it should
be made clear that the /proc filesystem - i.e. all files and directories
This is a quite flexible
hanging from this directory - do
mechanism,
since a file structure
not have any real existence on disk.
may be used to transfer data from
This is contrary to “normal” files the kernel to the user as in the
above example, or may also be
and directories such as
used to pass instructions from the
/etc/passwd or /home that
user to the kernel itself, thus
correspond to a specific location
and data on your hard drive. When parameterizing the way it works
while running. For example,
the user accesses one of these
network IP forwarding is off by
“real” files and directories, the
default. On a computer that works
kernel builds up internal data
structures to represent an image in as a router, forwarding between
memory of the directory structure network interfaces may be turned
on for IPv4 by issuing the command
on the disk, using the routines
full circle magazine #92
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# echo 1 >
/proc/sys/net/ipv4/ip_forward

and for IPv6 with
# echo 1 >
/proc/sys/net/ipv6/conf/all/f
orwarding

Default value '0' corresponds to
the 'off' state, while any positive
value turns the option on.
Naturally, we must act as root since
we are altering the system
configuration. This change will be
applied only while the kernel is
active; it must be re-applied after a
system reboot.

ANATOMY OF A
SIMPLE /PROC ENTRY
The /proc file-system is
controlled by source code in the
fs/proc/ subdirectory. To take a
simple example, consider the code
that generates the /proc/version
file on the fly:
$ cat /proc/version
Linux version 3.13.0-24generic (buildd@batsu) (gcc
contents ^
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version 4.8.2 (Ubuntu 4.8.219ubuntu1) ) #47-Ubuntu SMP
Fri May 2 23:30:00 UTC 2014

This code is contained in source
code file fs/proc/version.c. The
complete source code (as of kernel
version 3.1 3) is shown right.
Let's go over this part by part.
The first few #include lines include
header files from source code
directory include/linux/:
• <kernel.h> contains very basic
macro definitions used across the
source code.
• <init.h> contains initialization
code, and specifically the code that
we will use to initialize a module.
• <fs.h> contains basic definitions
for any part of the file-system, such
as codes to indicate file open for
read and for write, etc.
• <proc_fs.h> contains similar code,
but this time specific to the /proc
file-system.
• <seq_file.h> defines common
code for sequential file operations.
• <utsname.h> contains code to
access specific kernel data from
within user space.
This may seem overcomplicated to programmers used
to handling C code, since most of
the file-oriented routines may also

#include <linux/fs.h>
#include <linux/init.h>
#include <linux/kernel.h>
#include <linux/proc_fs.h>
#include <linux/seq_file.h>
#include <linux/utsname.h>
static int version_proc_show(struct seq_file *m, void *v)
{
seq_printf(m, linux_proc_banner,
utsname()->sysname,
utsname()->release,
utsname()->version);
return 0;
}
static int version_proc_open(struct inode *inode, struct file *file)
{
return single_open(file, version_proc_show, NULL);
}
static const struct file_operations version_proc_fops = {
.open = version_proc_open,
.read = seq_read,
.llseek = seq_lseek,
.release = single_release,
};
static int __init proc_version_init(void)
{
proc_create("version", 0, NULL, &version_proc_fops);
return 0;
}
module_init(proc_version_init);

be found in standard C header files
such as <stdio.h>. However, it
should be noted that these
standard I/O routines such as
“printf” are actually compiled into
the glibc library file – which the
kernel cannot access from disk
until the file system is ready. In
fact, if mounting the boot drive
does not work at all, the kernel
may very well not have access to
full circle magazine #92

the standard C libraries, while at
the same time needing very much
to emit an error message to inform
the user about what is going on!
This explains why file access and
outputting text on screen needed
to be built into the kernel itself.
Primitives are similar but not
always identical to the more
familiar glib versions; for example,
writing on screen is done with the
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“printk” command, though its
syntax is in fact identical to
“printf”.
Going down the code in file
fs/proc/version.c, we see that the
last line is
module_init(proc_version_init
);

This is where the code
contents ^
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controlling virtual file
/proc/version is loaded into
memory as a module. Now, so what
about this “proc_version_init”? This
(shown top right) is the procedure
that is declared just above module
initialization, that defines what
should be done when the module is
installed. All it needs to do is
create the virtual file “version”
within the /proc framework, and
assign to it a table of callback
functions that will be invoked
when usual operations are
performed on the virtual file.
The table of callback functions
is named “file_operations
version_proc_fops” (right). Of
these, only the open operation has
been defined, in function
“version_proc_open”. The other
three functions are left at their
default values.
Immediately before, function
“version_proc_open” has been
defined as shown right (third
down).
This simply does a sequential
file write “seq_printf” of the linux
version banner, the system name
on which it is running, and release
and version numbers.

MODIFYING A /PROC
ENTRY
The /proc/version file is perhaps
not a very interesting proposition
to modify. File /proc/cpuinfo spits
out quite a lot of information that
may allow more tweaking:
$ cat /proc/cpuinfo
[...]
processor
: 3
vendor_id
:
GenuineIntel
cpu family
: 6
model
: 37
model name
: Intel(R)
Core(TM) i5 CPU M 460 @
2.53GHz
stepping
: 5
microcode
: 0x2
cpu MHz
: 2527.207
cache size
: 3072 KB
[...]

static int __init proc_version_init(void)
{
proc_create("version", 0, NULL, &version_proc_fops);
return 0;
}

static const struct file_operations version_proc_fops = {
.open = version_proc_open,
.read = seq_read,
.llseek = seq_lseek,
.release = single_release,
};

static int version_proc_show(struct seq_file *m, void *v)
{
seq_printf(m, linux_proc_banner,
utsname()->sysname,
utsname()->release,
utsname()->version);
return 0;
}

To find out how to change this, “cpuinfo_open”, and is simply
defined as shown below.
(Some parts have been edited for brevity). our first stop will be file cpuinfo.c
in source code directory fs/proc.
This means we now need to find
All this information is given for This file has a similar structure to
out where symbol “cpuinfo_op” has
each processor core present in the version.c, except for the callback
been pre-defined in the kernel
system. This can be nice to have to routine invoked when an open
source code. This can be searched
operation is performed on virtual
identify a CPU or its number of
out either using some imaginative
file
/proc/cpuinfo.
In
the
case
of
cores – without needing to peruse
configurations of the grep
cpuinfo.c, the procedure is called
the documentation on the chip
itself. However, I have always been
a little dubious about the
extern const struct seq_operations cpuinfo_op;
presentation. I would prefer to
static int cpuinfo_open(struct inode *inode, struct file
*file)
have less information, but more
{
pertinent to my specific needs.
return seq_open(file, &cpuinfo_op);
}

full circle magazine #92
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command, or perhaps more easily
with the Linux Cross Reference
tool at Free Electrons:
http://lxr.free-electrons.com/ . This
has a very useful search engine
that will help us find words or
symbols wherever they are within
the linux kernel source code (try
“Identifier search”).
In any case, the appropriate
code can be found in file
arch/x86/kernel/cpu/proc.c . If we
study procedure:
static int
show_cpuinfo(struct seq_file
*m, void *v)

we will see how the information
given in /proc/cpuinfo is
progressively appended
sequentially to the output file.
Starting at line number 60, we find
that which is shown top right.
All this can be commented out,
and replaced by our own code. It
may be a good idea to mark the
modifications with appropriate
comments. I altered procedure
show_cpuinfo in file
arch/x86/kernel/cpu/proc.c and put
my code shown right (second
down).

This is a quick modification of
the original code written by the
kernel developers.
The kernel now needs to be
recompiled, and then reinstalled in
the /boot directory and the GRUB
entries updated. Since we have
modified no modules, it shall not
be necessary to recompile and
reinstall them, so if we have
already compiled the kernel at
least once previously, the process
needs to do less work this time and
should complete rather more
rapidly. So:
$ make
$ sudo bash
# make install

When tampering with file
arch/x86/kernel/cpu/proc.c, we
commented out the use of several
of the existing functions. The
compiler will complain with the
following message:
warning: ‘show_cpuinfo_core’
defined but not used [Wunused-function]
static void
show_cpuinfo_core(struct
seq_file *m, struct
cpuinfo_x86 *c,

full circle magazine #92

seq_printf(m, "processor\t: %u\n"
"vendor_id\t: %s\n"
"cpu family\t: %d\n"
"model\t\t: %u\n"
"model name\t: %s\n",
cpu,
c->x86_vendor_id[0] ? c->x86_vendor_id : "unknown",
c->x86,
c->x86_model,
c->x86_model_id[0] ? c->x86_model_id : "unknown");

/* -- by Alan -- */
seq_printf(m,
"CPU[%d]:\n\t%s %s\n",
cpu,
c->x86_vendor_id[0] ? c->x86_vendor_id : "unknown",
c->x86_model_id[0] ? c->x86_model_id : "unknown");
if (cpu_has(c, X86_FEATURE_TSC)) {
unsigned int freq = cpufreq_quick_get(cpu);
if (!freq)
freq = cpu_khz;
seq_printf(m, "\t%ld.%06lu GHz\n",
freq / 1000000, (freq % 1000000));
}
seq_printf(m, "\tcpu cores\t: %d\n", c->booted_cores);
/* -- end by Alan -- */

This is not a problem for our
simple experiment, though if
submitting code to the actual linux
kernel project, it would be best to
clean things up a little. Otherwise,
you may get shouted at!
When compilation is over and
the new kernel is installed, boot
from it. No visible changes should
be observed on the desktop - the
two mushrooms were already
there on the old kernel. Now re-
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examine the contents of
/proc/cpuinfo. It should now
correspond to whatever you put in
proc.c:
$ cat /proc/cpuinfo
CPU[0]:
GenuineIntel Intel(R)
Core(TM) i5 CPU M 460 @
2.53GHz
2.527462 GHz
cpu cores
: 2
[...]

This is more compact, looks
contents ^
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better and is more readable to my
eyes.

inverse: tweaking the kernel's
internal processes while running.

In this part of our series on
compiling the linux kernel, we saw
how to introduce small
modifications into the kernel
source code. The /proc virtual filesystem is a good place to start
trying out our own code, at first
just to obtain information from the
kernel. Later on, the more
adventurous could also try the

In the next - and last installment, we will try out a new
module, written from scratch and
added to the default kernel source
tree.
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Alan teaches computer science at

Escola Andorrana de Batxillerat
(high-school). He has previously
given GNU/Linux courses at the
University of Andorra and GNU/Linux
systems administration at the Open
University of Catalunya (UOC).
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Written by Charles McColm

SH is awesome. Tools like
Midnight Commander (mc) are
also really handy. Sadly, I’m a bit of
a lazy admin and like to do some
tasks graphically. A few days ago, I
found that I needed to add text to
the filename of a bunch of movies
on my XBMC machine. I could have
connected a keyboard and mouse
to the machine (only an infrared
receiver is connected to the USB
port), logged out of the XBMC
account, logged in to the openbox
interface, and started renaming
files, but I found a nice graphical
tool to batch rename files. I just
needed to figure a way to remotely
mount the movie folder on our
XBMC machine.
The answer was the sshfs
package. I use Xubuntu on most of
my systems, and sshfs is not
installed by default. Installing
software is one job I prefer doing
from the terminal, it’s just quicker:

from:
mkdir ~/sftp

example, we mount the remote
/data/Movies directory on the local
/home/charles/sftp directory. You
can also use the IP of your xbmc
machine rather than the hostname.

Now we’ll mount the remote
file system. In this example, I’m
going to use xbmc for the
ssfs
xbmc@192.168.1.10:/data/Movie
username on my XBMC remote
s /home/charles/sftp
server (which is called xbmc), and
charles as my username on my local
Now that we have the remote
machine. Replace xbmc and charles system mounted, we need a
with whatever username you use.
program to rename the files. Of
course you can do this with mv and
sshfs xbmc@xbmc:/data/Movies
/home/charles/sftp/
regular expressions, but I find that I
have a bad habit of messing up and
Notice that you do not have to
forgetting to do something so I
sudo to mount the remote file
end up with botched filenames.
system. You will, however, have to There are a few graphical tools to
know the password for the user on rename files, but the one that
the remote system. In this
worked best for me was gprename.

One of the great features of
gprename is the ability to preview
your changes. I always preview
changes in case I’ve messed up
which letter/string to remove or
add. Sometimes I also notice other
things that also need changing
while previewing.
In the screenshot example,
below, I started with the idea that I
would replace the small and in
Harry Potter and the … with a
capital And, but after previewing I
noticed that I should also capitalize
the T in The – so the filename
matches with the rest of the Harry
Potter series. I made the change
and previewed again before I
clicked the Rename button.

sudo apt-get install sshfs

Mounting a remote partition is
easy once sshfs is installed. But
first I’ll make a directory to work
full circle magazine #92
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Renaming is just one of the
functions you can do with
GPRename. Sometimes it’s nice to
add or strip out text. I’ve started to
differentiate some of my media by
adding the text DVD or Blueray to
the end of the file. Just switch to
the Insert/Delete tab to add or
remove text. Unfortunately,
gprename doesn’t know where the
end of the filename is and the
extension begins so you have to
count out where you want the text.
In the next graphical example, I add
“ - DVD” (a space, a dash, another
space and the word DVD) to the
1 2th position in the filename.

you have a bunch of music files
that begin 1 . song_name.mp3, 2.
songname.mp3, 3. songname.mp3
you would delete 0 to 2.

about messing up your files, use
gprename and preview before you
rename.

Once you’re done, don’t forget
to close gprename – or sshfs might
not be able to unmount the
filesystem. You cannot simply
umount ~/sftp.
SSHfs uses fuse to mount the
file system. To unmount ~/sftp use:
fusermount -u ~/sftp

Again you do not need to sudo
because you’re mounting on your
own home directory.

If you have lots of files with text
in the same spot that you want to
GPrename also works with
get rid of, you can select the delete directories. Regular expressions
option and choose which positions are more handy, but if you haven’t
to delete between. For example, if learned regexp, or are worried
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Charles is the author of Instant

XBMC, and project manager of a notfor-profit computer reuse project.
When not building PCs, removing
malware, and encouraging people to
use GNU/Linux, Charles works on
reinventing his blog at
http://www.charlesmccolm.com.
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Written by Christo A Van Wyk

Scilab description : Scientific

software package for numerical
computations. Scilab is a matrixbasedscientific software package.
Scilab contains hundreds ofbuilt-in
mathematical functions, rich data
structures (including polynomials,
rationals, linear systems, lists, etc...),
andcomes with a number ofspecific
toolboxes for control, signal
processing, etc. This package also
provides Xcos, a graphical editor to
design hybriddynamic systems
models. Models can be designed,
loaded, saved, compiledand
simulated. A stable andefficient
solution for industrial andacademic
needs, Xcos provides functions for
modelling ofmechanical systems
(automotive, aeronautics...),
hydraulic circuits (dam, pipe
modelling...), control systems, etc.
Modelica capabilities are also
provided.

With any piece of software, the
first thing I try to do is use the
software to see how easy it is
to use. Then I'll look at the help
section to see how to do the
things I want to do. If that does
not suffice, I'll look at the
documentation.

On ease of use, Scilab is as
simple to use as a calculator. Just
type in a calculation and press
enter. Scilab can also do more
involved mathematics such as
finding the roots of polynomials.

Just search in the help section
for roots. There is an example
script that can either be viewed
and executed from Scinotes
(Scilab's text editor) or directly in
Scilab.

I

am totally blown away with the
features available in Scilab, in my
opinion rivalling Matlab, and
definitely ahead of Octave
(Octave's new GUI should be
released soon).
full circle magazine #92

35

contents ^

REVIEW

There is a plethora of online
documentation, online tutorials
and websites available. A great
website I used for control
systems is Scilab Ninja. The
Scilab for beginners guide,
available from the Scilab
Enterprises website, is also
excellent.
By far my favourite part of
Scilab is Xcos – the model diagram
editor. It is Scilab's version of
Mathworks Simulink. It can model a
number of systems from control
engineering, to electric circuits and
physical systems. The feature I
found most useful is that Xcos can
be integrated into Scilab scripts
written in Scinotes to run model
diagram simulations with given
parameters.

Xcos doubles as a circuit simulator

Cons:

• Scilab crashes if you press enter
without entering data
• Xcos crashes Scilab if block
diagrams are given unknown
references

CONCLUSION

Scilab is truly a marvel of free
software engineering. I did not
even begin to scratch the surface
of the usefulness of Scilab for
mathematics, engineering and
physics. This software can and
should be used in high-schools and
universities. Scilab is far easier to
learn and start using than Octave.
Scilab is one of those software
programs that makes you go wow! I
can't believe this is free. The

occasional crash is the only thing
costing Scilab a perfect review. I'm
sure within the next release these
minor issues will be sorted out.

To get a feel of what Scilab is
capable of there is a
demonstrations feature. There are
many demos and it seems more will
be added in the future.

Pros:

• Lots of features
• It’s free
• Easy to use
• Excellent help section and
demonstrations
• Includes Xcos
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B u i l d Yo u r O w n W e b s i t e

Written by Mark Crutch

comic pastiche of The Wizard of Oz
intermingled with a normal
technical book. When gluing
disparate styles and topics
together, it can sometimes be hard
to produce a coherent result. So
did this book manage to combine
everything cleanly, or is the result a
bit of a jumble?
Since the book is billed as “a
comic guide...” I'll start with the
comic. It follows the adventures of
the comic's artist, Kim Gee, as she
attempts to create her first web
site, and is used to introduce the
main themes of each chapter in a
light-hearted and easy-to-read
manner. The artwork is printed in
Publisher: No Starch Press
black and white, and is perfectly
Pages: 264, black & white
functional if not particularly
ISBN: 978-1 -59327-522-8
http://www.nostarch.com/website inspiring. This is definitely an
educational comic, albeit one that
comic
doesn't take itself too seriously.
uild Your Own Website is very But it's worth reinforcing that this
is not a comic book for children,
much a book of two halves,
whichever way you slice it. Divide it despite the colorful cover – not
unless your kids are likely to prefer
by page count and you've got the
an educational tale about learning
beginnings of two very good
HTML to something involving
books, one on HTML and CSS, and
Spiderman or My Little Pony.
the other covering WordPress.
Divide it by style and you've got a
full circle magazine #92

Once Kim has completed each
stage in her journey, the rest of the
chapter reinforces what you've just
learnt. It retreads the themes from
the comic in more detail, and reads
more like any ordinary technical
self-help book would. These
sections hold the bulk of the detail
in the book, and are well written
and easy to follow. If you're an
absolute novice at HTML and CSS,
then over the first half of the book
these sections should do a good
job of getting you up to speed on

the basics.
When you reach the chapter 4,
however, the book changes tack
significantly. Everything you've just
learnt about HTML and CSS is
swept aside in favour of using
WordPress. There's the occasional
nod to the possibility of writing
your posts in raw HTML, but the
authors clearly think you should be
using the visual editor instead. The
rest of the book just covers the
main parts of WordPress and how

B
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REVIEW

to install it. I say “install it”, but
don't think you're getting a rundown on PHP and MySQL in this
book: the only options that are
really considered are to use a
wordpress.com account, or to find
a host which offers a one-click
install of WordPress as part of their
package. There are some basic
examples of three such hosts
given, but these are all US-centric.

coding it yourself or using
WordPress, this might give you just
enough insight into both
approaches to make that decision.
But if you already know which

approach you want to take, then at
least half of this book will be
wasted on you, whatever your
choice.

There are the beginnings of two
good books here – but the endings
of neither of them. Continuing the
HTML and CSS to the full length of
the book would have allowed for
more complex examples, perhaps a
little Javascript, and an
introduction to the browser's
developer tools for debugging
your site. A book this length on
WordPress alone would have
allowed the main topics a bit more
breathing room, and given the
opportunity to delve into more
detail on some useful widgets,
themes and plug-ins.
I find it hard to recommend this
book, not because there's anything
particularly wrong with it, but
rather because I don't know who I
would recommend it to. If you
want to create a website, but don't
know enough to decide between

full circle magazine #92
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M Y S TO RY

Written by Kavinda Bandara

have been using Linux for the
last seven years, first five as a
dual boot with Windows, and the
last two solely dependent on
Ubuntu. In the early days, I tried
Redhat and Fedora, and with the
live CDs I completely shifted to
Ubuntu.

1 2.04 LTS so I kept it that way.

From the beginning, the
wireless didn’t seem to function
well. But I usually used a 3G dongle
to connect to the Internet. So the
wireless didn’t give me a problem
in the early days. Once I bought my
new Smartphone, I couldn’t
connect it to the laptop via
Being a doctor by profession,
Bluetooth or wireless. Then I
this was an odd combination (as
many others found it nauseating to started to troubleshoot.
take the bitter pill and stay on the
After doing a thorough search
learning curve), but I always
of
literature
in the community
managed to find alternatives to the
support, I started with reinstalling
Windows software others used.
network manager, tried with
The simplicity, stability and good
different managers, and then
reliable updates and the
handled the drivers. I tried
trustworthy community always
reinstalling the existing ones, and
were the blessings for me to stay
then tried different suggestions
on the track.
given by the community.
As my previous laptop died
On one fine day, when I was
after 6 years of service (HP 9000
trying to fix the drivers, the
series), I bought a new one last
wireless suddenly disappeared
year. This is a Dell 3521 , coming
with Intel core i3, 500GB HDD, 4GB from the list. (I am so sorry I cannot
post the link to the thread here, as I
RAM, hybrid graphics with AMD
lost it with system reinstallation). I
RADEON 7670M and Intel HD
tried with “lspci” several times, and
Graphics 4000, and Dell wireless
1 704 (manufactured by Broadcom). with reinstallation of default
This came preinstalled with Ubuntu factory drivers. And then I tried
full circle magazine #92

with a live boot, but the result was
the same. I decided to hand over
the job to the shop where I bought
the laptop, as the laptop was still in
the warranty period.

ourselves is the main question I had
so far. Why did we have a ‘long
term support’ system if we couldn’t
tackle problems for the next four
years? And it would have been easy
if we categorized and ranked the
community threads.

What they did was installation
of a trial version of Windows 7 and
installation of drivers! And the
I’m still using the trial version,
wireless is working!!! And I could do and waiting impatiently to install
all the stuff I wanted.
1 4.04. I wish everything would go
fine and I could get rid of Windows.
I felt bad about the situation.
It’s always a bad dream to go back
Why that happened and why we
to Windows.
couldn’t solve the situation by
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LE TTE RS
M ULTIPLE PASSWORDS
ARTICLE

If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

"Personal" (with no .csv or quotes)
– just the word – to allow the script
to run unmodified.
3. Open Terminal on your
he HowTo article in FCM#91
computer with the 3-finger
(page 1 6 and 1 7) sparked my
command "Ctrl+Alt+T" (without
interest. I downloaded the script
quotes).
and would like to learn how to use 4. Install ccrypt with the terminal
it. I know nothing about scripting.
command "sudo apt-get install
Don't know if I will ever do much
ccrypt" (without quotes).
scripting, but I like to learn new
5. Save the script from the URL:
stuff. I am looking at 'Bash Guide
http://fullcirclemagazine.org/wpfor Beginners' and have a question: content/uploads/201 4/1 1 /multiple
What is an example of one entry in -password-script.txt to your home
David Mawdsley's password file.
folder – with the file "multiplepassword-script.txt" changed to a
At present I am using Lastpass
simple name such as "pwdir" (with
to manage my passwords. I can
no extension .txt – for typing ease).
export my passwords to a .csv file. 6. Using Terminal, issue the
If I copy and paste them into a text command "chmod u+x pwdir"
file, what comes first, second, etc, (without quotes), which will make
and separated by what?
the script able to run its
commands.
Harold
7. Run the script in Terminal with
"./pwdir" (without the quotes).
David says: To get started, there 8. The first time, encrypt your file
are a few things to do so that the
"Personal" using option 3 of the
script from the article will work
script. "cd" is to change directory.
without modification:
Type "Desktop/pw" (without
1 . On the desktop create a folder
quotes). (Don't forget to write
named "pw".
down the password that you use.)
2. Copy your .csv file to the folder
with its name changed to
full circle magazine #92

T

At this point you should have
"Personal.cpt" in your "pw" folder,
and it's encrypted. Now it's easier
to use Option 2 to decrypt and
view "Personal" in gedit. When you
close the text file "Personal", you'll
finish up by the encrypting dialog.
Finally close Terminal with the
command "exit" (without the
quotes).

EPUB

I

t is not a major crisis to me, but it
is unusual that the first character
in each article in the epub version I
read is set one line up from the
first sentence?
I am using Android Nexus 7
(WiFi) (201 2) with Android 4.4.4 to
run the latest Aldiko Pro to do my
reading with.

Alf Stockton
Brian says: Thank you for
bringing this to my attention. The
first letter of each article is usually
a drop cap which Aldiko is showing
as a single letter on a separate line.
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Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We are
always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.
contents ^

LETTERS
What you should be seeing is
something like this:

Aldiko, by default, expects
epubs to be generated by Adobe
Indesign, which, by default, does
not explicitly support drop caps
although by a bit of magic can be
made to do so:
https://www.video2brain.com/en/l
essons/adding-drop-caps
I usually check out the epub
version in Moon+ as it is my
preferred reader on Android, and,
of course, it displays as I expect it
to.

Whilst this review is outdated,
the comments and findings pretty
much hold today.

in each article but I doubt that
many readers would want to
bother.

A similar problem can occur
when using Calibre to convert files
for the Kindle. If the choice is
MOBI, then the drop cap appears
on a separate line. If the choice is
AZW3 then it is displayed correctly.

It is a problem similar to
different Web Browsers displaying
content differently – which seems
to being slowly resolved as they
converge on a common standard
kicking and screaming.

Because of the problems that a
different format for the first
character in an article causes in so
many epub readers, it makes sense
to discontinue its use from now on.
Maybe it will come back when
more widely and consistently
supported. So from Issue #92,
there will be no special first
character for articles in the EPUB
version.

I did research to find a simple
solution for you, but ran into a
brick wall other than to suggest

changing reader app.
Thanks again for your feedback
which is very helpful and thought
provoking.

It is possible to edit the files
A fairly recent and
using Calibre, Sigil, or a text editor
comprehensive review of the
to change the lines like
advantages and disadvantages of
several readers can be found at
<p class="dropcap">P</p>
http://blog.fogdo.net/archive/ebook_readers,_the_android_way.ht <p class="text">ython makes a
triumphant return this
ml. It's long but worth a read.
month...............</p>
This table from that site shows
the abilities of various readers to
display the first character:

to read
<p class="text">Python makes
a triumphant return this
month...............</p>

full circle magazine #92

41

contents ^

Q &A

If you have a Linux question, email it to: misc@fullcirclemagazine.org , and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

Compiled by Gord Campbell

an image from a
Q PDFCan andI extract
save it as a jpg?

folder and double click the file. The
You will always get at least one
software center should launch and line of output, so ignore the last
after several seconds you should
line.
see the Unetbootin install button.
Yes, open the PDF in Gimp,
Look at the details and it should
and tell it what page the
What is the easiest way to find
image is on. Then you can "save as." say it is version 603.
the IP address of a domain?
Gimp may prompt you to "flatten
the image," so just do as it asks,
Today I installed Ubuntu 1 4.04
Use the host command, eg:
then "save as."
LTS next to my Windows 7
Professional. The first thing I
host ubuntu.com
Where are the 1 3.04 package noticed was that my mouse,
plugged into my only USB 2.0 port,
repositories?
was not working. It's a Razer Naga,
What is the easiest way to get
1 3.04, and 1 3.1 0, had just nine which has coloured LED flashing
all my applications onto a new
when it is powered, and it was all
months of support. The
machine?
dark. So I plugged it into the 3.0
current supported releases are
port, and it worked right away.
1 2.04, 1 4.04 and 1 4.1 0.
Everything you have installed
or updated is in
(Thanks to Morgaes in the
/var/cache/apt/archives – unless
Ubuntu Forums) This is fixed
I want to install the latest
you have run apt-get clean.
in Ubuntu 1 4.1 0.
unetbootin in Ubuntu 1 4.04.

A
Q

Q

A

Q

Q

A
Q

A

(Thanks to nerdtron in the
Ubuntu Forums) The latest
one compatible with Ubuntu 1 4.04
is unetbootin 603. Here's a
download link:
http://unetbootin.en.uptodown.co
m/ubuntu/download/77793

A

A
Q

You could delete the old
versions for which there has been
How can I check on whether
the process myproc is running? an update, then copy your
applications to your new computer
and install each of the programs.
Enter the following
command:

A

TOP QUESTIONS AT
ASKUBUNTU
* Making Ubuntu Download
Bootable from USB
http://goo.gl/yqj3rD
* What's wrong with using sudo?
http://goo.gl/Im6YIk
* How to "cat" or "less" a
libreoffice writer .odt file?
http://goo.gl/4wUMXs
* Dividing an existing Ubuntu
installation on two physical drives
http://goo.gl/NBGPci
* How to get the path to a file in
your system
http://goo.gl/C22KGq
* how to back up with terminal
http://goo.gl/zMxEkP
* How do rootkits get installed on
to a ubuntu server?
http://goo.gl/IoMEvD
* How do I type an 'ae' character?
http://goo.gl/cS3Hb0
* Add column from one .csv to
another .csv file
http://goo.gl/GveRJF

ps aux | grep myproc

Now go to the Downloads
full circle magazine #92
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Q&A
TIPS AND TECHNIQUES

every computer survived the move. pfSense, the world-class free
We knew that if we didn't have
firewall/router software. It worked
backup, it would lead to a
great!
catastrophe.
You can also buy versions with
One of the areas the carpenters no memory and no hard drive. Get
didn't have ready was for the
the one with an i5, add 1 6 GB of
receptionist, at the front door. We memory and a big SSD, and you
installed an old laptop, running
have a powerhouse. It's not
Linux, with a webcam, so she can
particularly cheap, but hugely cool.
see what's happening at the front
door from her Windows PC at her
temporary location. X1 1 vnc rocks.

Lessons from a move

As previously mentioned, my
client moved to a new office
recently. The biggest lesson from
the move is that planning pays off.
Several parts of the move did
not go well. On moving day, there
were carpenters, painters, movers,
and two guys putting together a
server rack, all tripping over each
other. Oh, the server rack was our
part, and it turned out that we
should have allowed four weeks
for delivery. The day before the
move, my business partner spent
five hours in bad-weather traffic,
going and picking up the rack.

The first floor has three rooms
for meetings with clients, and the
boss wanted them to have cool
technology. We went with wallmounted Samsung smart TVs, with
cables in the wall going to a hidden
Zbox PC. The Zbox is tiny! Then we
added wireless keyboard and
mouse combos, so all the client
sees is the TV, apparently operated
from a disembodied keyboard and
mouse. There are many
configurations of Zbox; we went
with the ID91 Plus, which has a
fairly fast Core i3, 4 GB of memory,
and 500 GB hard drive. The tiny
Zbox sure works nicely.

Other than that, our part of the
move went perfectly. I'm sure that
either one of us, on our own, would
have had about 80% of it covered,
but together we aced it. It didn't
matter that we spent moving-day
assembling the rack, which arrived
as 40 pieces of angle-iron, with
more than enough nuts and bolts
to put it together. We didn't have
computers to install, and desks to
put them on, until two days later.
We had complete backup, so
full circle magazine #92

The Zbox comes with no OS, and
when I booted from a Mint Live CD,
it all worked. It has two gigabit
Ethernet ports, so I tried installing
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Gord had a long career in the

computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 1 5-person accounting firm in
downtown Toronto.
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I

Written by Ronnie Tucker

f you’ve been following my
previous X-Plane tutorials, then
you should have an awesome
looking X-Plane with real-time
tracking and all sorts of whizz-bang
effects.
But what about a flight plan?
Actually creating a flight plan is
easy enough: the X-Plane FlightPlanner website:
http://xplane.anzui.de:3000/flightplanner.
On the site (using the small ‘+’
icon), you can show/hide various
overlays such as routes, fixes,
airports, etc. You can also change
the map type from roads to
satellite, or even use the
Openstreet map.

The blue (and pale blue) circles
with what looks like an ‘X’ are
airports, while the blue circles with
a white ‘H’ are heliports. The white
triangles are fixes. You can click
any of them to get a popup with
info. Airports will give you info
such as radio frequencies and their
name (eg: EGPF), while the fixes
will just have a name (eg: GOW1 2).
Let’s say I’m flying out of
Glasgow airport and ultimately
want to land at Edinburgh, but
want to go via a fix. In other words:
I don’t want to just go in a straight
line from A to B.
First, I click Glasgow airport, and
click the link that says ‘add as
waypoint’:

full circle magazine #92

X- P l a n e : E n t e ri n g A F l i g h t P l a n
As you can see, it’s added
Glasgow (EGPF) to the column on
the right. Next, I click Edinburgh,
and do the same:

As you can see, it’s a bit bland.
Let’s add a fix. Click a white
triangle and add it too.

waypoints around. Drag the fix (the
red box) on the right-hand column
up to become the middle point.

That’s better. You can click the
EDIT button at the top right to
enter information such as aircraft,
fuel, etc. But let’s keep it simple for
now.

NOTE: If you’re using a plane with a
flight management computer
(FMC) that allows importing of
flight plans, then you can use the
EDIT button to export your flight
plan as a .FMC file.

Oops! It’s OK. I purposely
entered the middle point last to
show that you can move your
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So, none of that was done in XPlane. Now what? Well, time to
load up X-Plane, and hop inside
your favourite plane, and click the
Garmin GPS. It should open in a
contents ^

UBUNTU GAMES

new window within X-Plane:

starting airport with a line drawn to
So, with your flight plan in the
the fix, then to your destination.
GPS, it’s time to fire up your bird,
and enable the autopilot, and enjoy
the view!
There’s still a lot more that the
Garmin 530 can do. You can
program it for a specific approach
where it’ll pretty much line you up
and all you need to do is slow
down, go into approach mode, and
get your wheels on the tarmac.

ACCEPT? Press ENT to accept.
Unfortunately, the Garmin/XPlane 530 is a bit awkward to use
since it has no keys. Everything has
to be done using the two revolving
dials on either bottom side of it.
Like radio buttons, there’s a larger
outer dial, and a smaller inner dial.
Each also has a push button in the
middle.
First, press CDI and make sure
VLOC becomes GPS. I prefer GPS
over VLOC. Now, press FPL. As it
says, this is your active flight plan.
At the moment it’s empty. But,
press the middle of the right dial,
then click the inner smaller dial to
begin entering your starting point.
After the first letter, click the
larger dial to enter the next letter,
and so on. In my case I’m entering
EGPF. When entered, press ENT.

Now you have your starting
point in. Do the same thing for the
fix and the destination.

Pretty fiddly, huh? Well, fear
not, it’s almost done, and, once it’s
entered, you’ll have the pleasure of
enjoying auto-pilot.
Press FPL again, and you'll go to
the radar/map mode. You may
need to use the up/down button at
the top-right to zoom in/out, but
you should see that you’re at your
full circle magazine #92
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M Y D E S KT O P

I

’m using Ubuntu 1 4.04(LTS). I
love simplicity, and my desktop
contains the following
customization:
• Numix icon circle theme

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

• Harmattan conky
• and last one...wallpaper :
• Numix GTK theme
http://goo.gl/9zh28p
• Indicators like netspeed indicator,
hardware sensor indicator,
Arpan Chavda
clipboard, uget
full circle magazine #92
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MY DESKTOP

M

y laptop is a Lenovo ideapad
S1 1 0, 2GB RAM, Intel Atom,
and a 1 6 GB SD card as the Hard
Drive (I broke my 320GB).
My OS is Lubuntu 1 4.04.1 LTS,

and it’s a very great OS. It's faster
than Unity/Gnome, doesn't load
itself in RAM unlike Puppy, not
buggy compared to
Bodhi/Enlightenment, and more
colorful than CTRL+ALT+F4. A true
full circle magazine #92

alternative to Windows XP!
The widget is Lubuntu-darkpanel, Icon Theme: Humanity,
Window Border Theme: Lubuntudefault. The wallpaper is Game of
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Thrones inspired.

reeglyson escabal
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H O W TO CO N TRI B U TE

Full Circle Team

FCM#89

FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's, reviews,
and anything else you want to tell your fellow *buntu users. Send your
articles to: articles@fullcirclemagazine.org

Deadline :

Sunday 1 1 th Jan. 201 5.
Release :
Friday 30th Jan. 201 5.

We are always looking for new articles to include in Full Circle. For help and advice please
see the Official Full Circle Style Guide : http://url.fullcirclemagazine.org/75d471
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our forum via: fullcirclemagazine.org

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org
Editing & Proofreading
Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with
the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.

Google Play - You can now read Full Circle on Google Play/Books. Either search for 'full circle magazine' or
click this link: https://play.google.com/store/books/author?id=Ronnie+Tucker
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